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Quick reference: Excel shortcut keys 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Command Keystroke 

Absolute/relative/mixed reference F4 

AutoSum Alt = 

Bold Ctrl-B 

Border lines off Ctrl-Shift _ 

Border lines on Ctrl-Shift & 

Close Ctrl-W 

Copy Ctrl-C 

Cut Ctrl-X 

Show values/formulas Ctrl-pipe key (below Esc) 

Edit cell F2 

Find Ctrl-F 

Format commas (2 decimal places) Ctrl-Shift ! 

Format currency (2 decimal places) Ctrl-Shift $ 

Format general number Ctrl-Shift ~ 

Format percentage (0 decimal places) Ctrl-Shift % 

Formula = 

Function Wizard Shift-F3 

Insert chart sheet F11 

Italics Ctrl-I 

Move left/right one screen Alt-PgUp/PgDn 

Move to beginning of worksheet Ctrl-Home 

Move to edge of region Ctrl-Arrow 

Move to end of row End, Enter 

Move to end of worksheet Ctrl-End 

New Ctrl-N 

Next worksheet Ctrl-PgUp 

Open Ctrl-O 

Paste Ctrl-V 

Previous worksheet Ctrl-PgDn 

Print Ctrl-P 

Repeat/Redo Ctrl-Y 

Replace Ctrl-H 

Save Ctrl-S 

Select worksheet Ctrl-A 

Spelling and Grammar check F7 

Underline Ctrl-U 

Undo Ctrl-Z 
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Unit 1: Getting Started 
This unit focuses on familiarising you with the Excel environment, including spreadsheet 
terminology and navigation techniques. 

Unit objectives 

By the end of this unit, you will be able to: 

� Use terminology associated with spreadsheets 

� Identify various parts of the Excel window  

� Launch and search MS Excel Help 

� Use the mouse and shortcut keys to select and navigate in Excel  

� Close an Excel file and close the Excel program 

 

 

Spreadsheet terminology  

Before you begin creating spreadsheets, it is useful to be able to identify the various 
components that comprise a spreadsheet. 
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Exploring the Excel window  

The Excel window contains various components that are commonly used when creating, 
modifying and formatting spreadsheets and charts. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The Excel window 

 

 

 

Turning on toolbars and the Task Pane 

Excel’s toolbar and Task Pane can be turned on or off through the View menu. 

� To turn toolbars on or off, go to View-Toolbars. 

� To turn the Task Pane on or off, go to View-Task Pane. 

Task Pane 

Formatting toolbar 

Standard toolbar 

Menu bar 

Name box 

Insert Function 

button 
Formula bar 

Scroll bars 
Navigation 

buttons 
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Getting help  

All Microsoft applications contain an in-built Help feature which provides guidance on how to 
use a program’s features. 

There are four ways of accessing Help feature in Excel: 

� Through the Help menu, using the Office Assistant 

� Launch MS Excel Help using the button on the standard toolbar 

� Use the Ask a Question box at the top-right of the Excel window 

� Press the F1 key 

 

Try it! 

Use Excel’s Help feature to find information on how to open a file. 

 

Opening and navigating workbooks  

To open an Excel file, use the Open button on the standard toolbar 
or the shortcut keys Ctrl + O. 

Try it! 

Open the file Sales report.xls from the course files folder. 

 

Using the mouse to select and navigate  

 Use to select a cell or range of cells 

 Use to select a column, by clicking on a column header 

 

Use to select a row, by clicking on a row header 

 
Hold over a scroll bar, click and drag to scroll 

Try it! 

Practice using the mouse to select cells, rows and columns in Sales report.xls. 

 

Office Assistant Launch Excel Help Ask a Question box 
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Using keyboard shortcuts 

The following keyboard shortcuts can be used to navigate within and between worksheets in a 
file. 

 

Arrow keys Move one cell right, left, up or down 

Ctrl + arrow keys Move to the first or last cell that 
contains data in a row or column  

Page Up, Page Down Move up or down a worksheet 

Ctrl + Page Up, Ctrl + Page Down Move to the next or previous 
worksheet 

Ctrl + Home, Ctrl + End Move to start or end of spreadsheet 

 

Try it! 

Practice using the shortcut keys listed above in Sales report.xls. 

 

 

Closing workbooks 

The buttons located at the top-right of the Excel window can be used to close Excel files. 

 

 

 

 

 

 

 

 

Try it! 

Close the file Sales report.xls but keep the Excel program open. 

Closes all open Excel files and the 

Excel program 

Closes the Excel file currently open 

in the Excel window 
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Unit 1 Practice Activity 

 

1. Start Excel. 

2. Open the file Practice employee information.xls. 

3. Try using the following keys to change the selection of the active cell: 

a. Right, down, left and up arrow keys 

b. Ctrl and right, Ctrl and down, Ctrl and left and Ctrl and up keys 

c. Page Up and Page Down keys 

d. Ctrl and Page Down, Ctrl and Page Up 

e. Ctrl and End, Ctrl and Home 

 

4. Use the Ask a Question box (at the top right of the Excel window) to get help on closing a 
file. 

5. Close Help. 

6. Close Practice employee information but keep the Excel program open. 

 

 

 

Online support forum and knowledge base 

www.microsofttraining.net/forum 

Visit our forum to have your questions answered by our Microsoft certified 
trainers. 
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Unit 2: Entering and editing data 
This unit focuses on creating spreadsheets ‘from scratch’, including entering and editing labels, 
values and formulas. 

Unit objectives 

By the end of this unit, you will be able to: 

� Start a new Excel file  

� Enter labels, values and formulas into a spreadsheet 

� Use various methods to edit labels, values and formulas 

� Save an Excel file 

 

 

Creating workbooks 

To start a new Excel file, use the New button on the standard toolbar 
or the shortcut keys Ctrl + N. 

Try it! 

Start a new Excel file. Then close the new file without saving. 

 

Entering labels and values  

In spreadsheet terms, text is referred to as labels and numbers are referred to as values. 

 

Labels and values should be entered into separate cells in a spreadsheet, so that the values 
may be used as part of formulas, or calculations. 

 

Try it! 

Open Sales report.xls from the course files folder. 

On Sheet 1 enter details for Julian in row 7 as shown below.  

 

Handy hint: 

Values should be entered in without currency symbols or commas as these can be applied 
using number formats later on. 
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Using Undo/Redo 

Undo can be used to reverse previous changes you have made to your spreadsheet. 
To use Undo, click the button on the standard toolbar or use Ctrl + Z. 

Redo can be used to reverse changes made by pressing the Undo button. 
To use Redo, click the button on the standard toolbar or use Ctrl + Y. 

Try it! 

Using Sales report.xls, use Undo several times to reverse typing labels into row 7. 

 

Then use Redo to re-enter labels. 

 

 

Editing labels and values 

There are various ways to edit (make changes to) labels and values that have been entered into 
a spreadsheet. 

 

Editing using the formula bar 

Select the cell to be edited, and click in the formula bar to edit. 

 

 

Try it! 

On Sheet 1 of the file Sales report.xls, use the formula bar to edit the cell A2 to read 
Sales report for the Central region. 

 

Editing cell contents 

To edit directly inside a cell: 

� Double-click directly on the cell and use the arrow keys to move the cursor 

� Press the F2 key – the cursor appears at the end of the cell contents 

Try it! 

In Sales report.xls, switch to Sheet 2. 

Edit the cell A2 to read Sales targets for the Central region. 
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Editing using the Fill handle 

The Fill handle is a useful tool in Excel. Positioning your cursor over the bottom-right corner of 
the active cell brings the Fill handle up on your screen. 

 

 

 

The Fill handle can be used to quickly enter: 

� Quarters (Quarter 1, Quarter 2 etc). 

� Days of the week 

� Months of the year 

 

Try it! 

On Sheet 2 of the file Sales report.xls, type Qtr 1 into cell B4. 

Use the Fill handle to fill in Qtr 2, Qtr 3 and Qtr 4. 

Use the blank area under the spreadsheet on Sheet 2 to practice using the Fill handle to enter 
days of the week and months of the year. 

Type the first day or month (Monday or January), then use the Fill handle to enter in the 
following days or months. 

 

 

Deleting or replacing cell contents 

To clear cell contents, select a single cell or range of cells and press the Delete key. 

To replace the contents of a cell: 

� Select the cell and begin typing 

� Use Find and Replace to make the same replacement multiple times  
(Edit – Find and Replace or Ctrl + H)  

 

Try it! 

On Sheet 2 of Sales report.xls, select and delete the days of the week and months of the year 
entered in using the Fill handle on Sheet 2. 

On Sheet 2 of Sales report.xls, replace 60000 in cell B5 with 62000. 

Switch to Sheet 1. Use Find and Replace to replace the word Difference with Over/under target. 

The Fill handle 
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Entering and editing formulas  

Formulas are used to perform calculations in a spreadsheet, including addition, subtraction, 
multiplication and division. 

The main advantage of using formulas is that unlike a value that stays the same unless you edit 
it, the result of a formula will automatically recalculate itself in response to values in the 
spreadsheet being changed. 

Formulas can be easily recognised in a spreadsheet as all formulas begin with an 
equals sign =. 

 

Formula operators 

In order to create and interpret formulas, you will need to be able to recognise and enter the 
basic formulas operators: 

 

 

 

 

 

Try it! 

In Sheet 1 of the Sales report.xls file, enter a formula in cell D5 to calculate the difference 
between Sandra’s actual sales and her target for Quarter 1. The formula is =B5-C5. 

 

Create formulas to calculate the difference between Sandra’s actual and target sales for 
Quarters 2 and 3 in cells G5 and J5 respectively. 

 

In cell K5, create a formula to calculate Sandra’s ‘eligible for commission’ total. This is achieved 
by adding together any positive differences between her actual and target sales for each 
quarter. In other words, any quarter where Sandra exceeds her target sales, the amount that 
she exceeded her target by is eligible for commission. 

 

Calculate ‘eligible for commission’ totals for the other two salespeople in K6 and K7. 

 

In cell L5, create a formula to calculate the amount of commission Sandra is to be paid. 
The formula is =K5*L2. 

( ) Brackets ^ Exponent 

+ Addition * Multiplication 

- Subtraction / Division 
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Order of calculations – BEDMAS or BODMAS 

In formulas where there is more than one operator, for example, an addition and a multiplication, 
Excel will not necessarily calculate the result by reading the formula from left to right. 

Excel will follow a set rule for the order in which it performs calculations. BEDMAS or BODMAS 
are acronyms you can use to help you remember the order in which Excel will perform 
calculations. 

 

Letter Stands for Calculation 
order 

B Brackets 1
st
 

E or O Exponents or Order 2
nd

 

D Division 
3

rd
 

M Multiplication 

A Addition 
4

th
 

S Subtraction 

 

 

Try it! 

Apply the order of calculation rule to the formulas shown below and write in the result of the 
formula in the space provided. 

 

Formula Formula result would be: 

 

 

 

 

 

 

Saving and updating workbooks  

It is good practice to save changes to files as you are working to minimise the risk of losing work 
you have done. 

� To save a file for the first time, use the Save button or File – Save As 

� To save changes/updates to a file, use the Save button or Ctrl + S 

 

Try it! 

Save the changes you have made to Sales report.xls. 
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Unit 2 Practice Activity 

 

1. Create a new workbook. 

2. Enter data as shown in Example 1 below. 

3. In cell E5, enter the formulas to calculate the total costs for each item. 
Hint: multiply the cost per item by the quantity required. 

4. Use Undo to remove the formula you entered in E5, and then use Redo re-enter it. 

5. Save the workbook as Practice total costs. 

6. Compare the workbook to Example 2 below. 

7. Close the workbook. 

 

 

Example 1 

 

 

Example 2 – formulas for Total cost are shown on the right 
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Unit 3: Modifying a Worksheet 
Once a spreadsheet has been set up, it is likely that changes will need to be made to it. 
This unit focuses on methods that can be used to rearrange data in spreadsheets. 

Unit objectives 

By the end of this unit, you will be able to: 

� Use cut, copy and paste to move and copy spreadsheet data and formulas  

� Create absolute references in formulas  

� Modify spreadsheets by inserting and deleting ranges  

 

 

Moving and copying data  

Moving involves physically transferring data from one location to another, whereas copying 
refers to duplicating data so that it appears in more than one location. 

There are several methods that can be used to move or copy data. 

 

Toolbar buttons and shortcut keys 

The Cut, Copy and Paste buttons are located on the standard toolbar: 

� Use Cut and Paste to move data 

� Use Copy and Paste to copy data 

 

Try it! 

Switch to Sheet 3 in Sales report.xls. 

Use Cut and Paste to move the names that appear in cells A5:A7 to cells A8:A10. 

Then use Undo to move the names back to their previous location. 

Use Copy and Paste to copy the names that appear in cells A5:A7 to cells A8:A10. 

Then use Undo. 

Handy hint: 

Only one cell needs to be selected when pasting data – it is not necessary to try and select the 
same number of cells as you are moving or copying. 

Press the Esc key to remove the moving border from around copied or cut cells. 

Cut 

Ctrl + X 

Copy 

Ctrl + C 

Paste 

Ctrl + V 
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Using the Clipboard 

The Clipboard provides a more visual/pictorial interface for copying and pasting data. 

The Clipboard can be accessed through the Edit menu; or by using the dropdown arrow at the 
top of the Task Pane. 

Accessing Excel’s Clipboard 

Try it! 

Use the Edit menu or the dropdown arrow at the top of the Task Pane to display the Clipboard. 

On Sheet 3 of Sales report.xls, select cells C5:C7 and copy the cells. The values you have 
copied will show on the Clipboard. 

Select cell C8 then click on the copied values showing on the Clipboard. The values should now 
be pasted in cells C8:C10. 

 

Using the mouse 

Drag-and-drop methods: 

� Move data, by selecting it then dragging and dropping it to a different location 

� Copy data, by selecting it, and holding down Ctrl in conjunction with dragging and 
dropping 

Right mouse button: 

� Select the data, then right-click for cut and copy options 

� Select the destination cell for the data, then right-click for the paste option 

 

Try it! 

On Sheet 3 of Sales report.xls, use the mouse to move the values in cells C5:C7 to C8:C10. 

Use the mouse to copy the values in cells C8:C10 to C5:C7. 

Select the cells C8:C10 and delete the values from these cells. 
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Using the Paste Options Smart Tag 

The Paste Options smart tag appears on the screen after copied data has been pasted, 
providing various options that can be applied to the pasted data. 

The Paste Options smart tag can be turned off by going to Tools–Options–Edit and deselecting 
‘Show Paste Options buttons’. 

 

 

 

 

 

 

The Paste Options smart tag 

 

Deselecting copied data 

The moving border (‘marching ants’) around copied data can be removed by pressing the 
Esc key. 

This also removes the Paste Options smart tag from the screen. 
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Moving and copying formulas 

Formulas can also be moved or copied using the same methods you have practiced using to 
move or copy text. 

The only difference is that when formulas are copied, they do not stay the same like text or 
numbers – they change. 

 

Try it! 

On Sheet 1 of Sales report.xls, delete the formulas in cells G5 and J5. Copy the formula in cell 
D5 and paste it into cells G5 and J5. Note how the result of the formula changes when it is 
pasted into these two cells. 

Why does this happen? Your trainer will explain. 

 

 

 

 

 

 

 

 

Using the Fill handle 

Using the Fill handle provides a quick way to copy formulas across a row or down a column. 

 

Try it! 

 

Try it! 

On Sheet 1 of Sales report.xls use the Fill handle to copy down the formulas created in 
D5, G5, J5 and L5 to the next two rows (rows 6 and 7). 

Why do you get incorrect formula results appearing in cells L6 and L7? 

Discuss this with your trainer. 

 

 

 

 

 

 

 

 

Handy hint: 

Formulas can be displayed in a spreadsheet by using Ctrl + the ‘pipe’ key (directly below the 
Esc key).  

The Fill handle 
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Relative references in formulas 

Cell references (or cell names) that are used as part of a formula are by default relative cell 
references. ‘Relative’ in this case means that the cell references in the formula are viewed by 
Excel as being relative to the location of the formula itself. 

In the example on the left, Excel reads the 
formula in cell D5 as ‘take the value in the 
cell two columns to the left and minus the 
value in the cell one column to the left’. 

 

So when the formula is copied, Excel changes the cell references in the formula relative to 
where the formula is copied to. 

Therefore in cells D6 and D7, Excel will continue to ‘take the value in the cell two columns to the 
left and minus the value in the cell one column to the left’. 

 

Absolute references in formulas 

Sometimes when you create a formula it will be necessary to ‘fix’ or ‘lock’ particular cell 
references into a formula, so that when the formula is copied the results that show are correct. 

A cell reference that is fixed or locked into a formula is known as an absolute reference. 

The example below shows the cell L2 as an absolute reference in the formula in 
column L. An absolute reference has $ signs before the column letter and before the row 
number, so L2 becomes $L$2 in the formula shown below. 

 

When the formula is copied down column L, cell L2 remains fixed or locked into the formula. 

 

Handy hint: 

Create an absolute reference by pressing the F4 key once, immediately after the cell has been 
entered into the formula. 
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Try it! 

On Sheet 1 of Sales report.xls select cell L5. 

Change cell L2 in the formula into an absolute reference. This can be done by clicking next to 
L2 in the formula and pressing the F4 key once so the formula reads =K5*$L$2. 

Then use the Fill handle to copy the new formula down to cells L6 and L7. The correct formula 
results should now display. 

Use Ctrl + the ‘pipe’ key to display formulas and show the absolute reference in the formula in 
column L. 

Save the changes made to Sales report.xls. 

 

 

Inserting ranges  

Columns and rows may need to be added to or removed from an existing spreadsheet. 

In Excel, rows can only be inserted in an upward direction and columns can only be inserted 
to the left. 

 

To insert rows or columns: 

� Use Insert-Cells or right-click in a column or row and select Insert from the menu, then 
select Row or Column 

� Right-click on a row or column header and select Insert from the menu 

 

 

Using the Insert menu Click in a row or column and 
right-click 

Select the row or column header 
and right-click 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Handy hint: 

Insert multiple rows or columns by selecting more than one row or column header, right-clicking 
and selecting Insert from the menu. 
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Deleting ranges 

To delete rows or columns: 

� Use Edit-Delete… or right-click in a column or row and select Delete from the menu, 
then select Row or Column 

� Right-click on a row or column header and select Delete from the menu 

 

Using the Edit menu Click in a row or column and 
right-click 

Select the row or column header 
and right-click 

 

 

 

 

 

 

 

 

 

Handy hint: 

Delete multiple rows or columns by selecting more than one row or column header, right-clicking 
and selecting Delete from the menu. 

 

 

Try it! 

On Sheet 1 of Sales report.xls, delete Pam’s information (row 6) from the spreadsheet, then 
use Undo to bring it back. 

Insert three rows above the Totals row (row 8) at the bottom of the spreadsheet. These rows will 
display the data related to the three salespeople on Sheet 3 of Sales report.xls. 

Move the data for the three salespeople on Sheet 3 into the appropriate positions in the three 
newly created rows in Sheet 1. 

Use the Fill handle to copy down the formulas in columns D, G, and J. 

Calculate the ‘eligible for commission’ Total for each salespeople in column K. 

Use the Fill handle to copy down the formula in column L. 

Save the changes made to Sales report.xls. 
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Unit 3 Practice Activity 

 

1. Open Practice sales summary.xls. 

2. Delete the row containing the 2002 figures (row 3). 

3. Insert a new row between rows 1 and 2. Enter the heading Sales 2003-2007 into cell A2. 

4. Enter a formula to calculate the total sales for 2003 in F4. 

5. Use the AutoFill handle to copy the year total formula from F4 to F5:F7. 

6. In B8, enter formula that will calculate predicted sales for each quarter in 2007. 
For 2007, sales in each quarter are predicted to increase by 2% (on average) from same 
quarter in the previous year. Note that 2% has been entered into cell E10 to be used as part 
of the formula. 

7. Copy the formula in B8 to C8:E8. Check your formula results in C8:E8 – if the quarterly 
results are the same as those in the previous year then the formula in B8 needs correcting. 

8. Change the percentage in B8 from 2% to 1.5%. The predicted sales for 2007 should 
automatically recalculate once the percentage has been altered. 

9. Copy the formula from F7 down to F8, so total predicted sales for 2007 show in the 
spreadsheet. 

10. Save the workbook as My practice sales summary and close the workbook. 

 

 

Online support forum and knowledge base 

www.microsofttraining.net/forum 

Visit our forum to have your questions answered by our Microsoft certified 
trainers. 
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Unit 3 Practice Activity solution 

Upon completion of Unit 3 Practice Activity your formulas should match those shown below. 

Use Ctrl + the ‘pipe’ key (directly below the Esc key) to view formulas in your spreadsheet. 

 

Notes 

� Formulas in column F are created using the AutoSum button 

� Formula in row 8 uses an absolute reference – when the cell E10 is entered into the formula, press the F4 key to create an absolute reference 
($E$10). 
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Unit 4: Using Functions 
Functions are types of formulas that are pre-programmed into Excel in order to perform 
specific calculations. 

This unit is an introduction to some of the common Excel functions and their uses, including 
SUM, AVERAGE, MIN, MAX, COUNT and COUNTA. 

Different methods for entering functions into a spreadsheet will be covered. 

Unit objectives 

� Use the AutoSum button add values in a spreadsheet  

� Use a variety of methods to enter common functions such as AVERAGE, MIN, MAX, 
COUNT and COUNTA  

 

Using AutoSum 

The AutoSum button in Excel provides a quick way to add together values in a spreadsheet.  

 

 

To use AutoSum: 

� Select the cell where the formula is to appear in the spreadsheet 

� Click the AutoSum button – Excel automatically enters a formula into the cell for you 

� Check the formula to ensure it is accurate – edit the formula if necessary 

� Press Enter to confirm the formula and display the formula result. 

 

Try it! 

On Sheet 1 of Sales report.xls use the AutoSum button to calculate Total actual and target 
sales for each quarter in row 11. 
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Entering functions  

There are several ways of entering functions into a spreadsheet: 

� Using the Insert Function button 

� Using the AutoSum list 

� Manually entering the function 

 

Using the Insert Function button 

The Insert Function button is located near the top of the screen, adjacent to the formula bar: 

 

Clicking the Insert Function button activates the Insert Function dialogue box and provides 
access to the large range of functions available in Excel. 

 

Once the Insert Function dialogue box is open: 

� Select the function you wish to use from the available list and click OK or 

� Type the name of the function you wish to use in the Search for a function area, press 
Enter, select the function when it appears in the list and click OK. 

 

Insert Function button 
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In the Function Arguments dialogue box, click the button with the red arrow to select the 
range of cells to enter into the formula from the spreadsheet, then click OK. 

 

 

Try it! 

On Sheet 1 of Sales report.xls type Average into cell A12.  

Use the Insert Function button to calculate average actual and target sales for each quarter in 
row 12. 

 

Using the AutoSum List 

The dropdown arrow next to the AutoSum button provides access to common functions, and 
the Insert Function dialogue box. 

To insert function using the AutoSum list: 

� Select the cell where the formula is to appear in the spreadsheet 

� Select the function you wish to use from the AutoSum list 

� Check the formula to ensure it is accurate – edit the formula if necessary 

� Press Enter to confirm the formula and display the formula result. 

 

Try it! 

On Sheet 1 of Sales report.xls type Minimum into cell A13.  

Use the AutoSum list to calculate minimum actual and target sales for each quarter in row 13. 

 

Accesses the Insert Function dialogue 

box 
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Entering functions manually 

All the common functions follow the same basic structure: 

=function name(cell:cell) or =function name(cell,cell,cell) 

Therefore formulas containing functions can be typed directly into a cell in the spreadsheet. 

 

Try it! 

On Sheet 1 of Sales report.xls type Maximum into cell A14.  

Enter formulas to calculate maximum actual and target sales for each quarter into row 14. 

 

Type No. of employees into cell A15. 

Use any one of the three methods for inserting functions to enter the COUNT function into cell 
B15. The COUNT function can be used on cells that contain values, to determine how many 
values there are. In this case, we want to know how many employees there are. 

 

Handy hint: 

By changing the function from COUNT to COUNTA, cells containing labels can be counted as 
well as cells containing values. 

 

 

Using AutoCalc 

The AutoCalc feature in the status bar at the bottom-right of the Excel window can be used to 
find the result of using a particular function on cells that have been selected in the 
spreadsheet. 

Right-click on the AutoCalc area to select other functions – SUM shows by default. 

 

The AutoCalc feature 
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Unit 4 Practice Activity 

 

1. Open My Practice sales summary.xls.  This is the file you worked on for the Unit 3 
Practice Activity. 

2. Enter the labels Average, Minimum and Maximum into cells G3, H3 and I3 respectively. 

3. In cell G4, enter a function to calculate the average quarterly sales for 2003. Copy the 
formula down to row 8. 

4. In cell H4, enter a function to calculate the lowest quarterly sales value for 2003. Copy the 
formula down to row 8. 

5. In cell I4, enter a function to calculate the highest quarterly sales value for 2003. Copy the 
formula down to row 8. 

6. Save the changes made to My Practice sales summary and close the file. 

 

 

Online support forum and knowledge base 

www.microsofttraining.net/forum 

Visit our forum to have your questions answered by our Microsoft certified 
trainers. 
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Unit 4 Practice Activity solution 

Upon completion of Unit 4 Practice Activity your formulas should match those shown below. 

Use Ctrl + the ‘pipe’ key (directly below the Esc key) to view formulas in your spreadsheet. 

 

Notes 

Functions can be entered into columns G, H and I using any one of the three methods outlined in the Unit 4 notes (using the Insert Function button, using the 
AutoSum list or by entering functions manually into the spreadsheet). 
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Unit 5: Formatting Worksheets 
This unit focuses on how to use various formatting features in Excel, including text and 
number formatting. 

Formatting can be applied by selecting the cell or cells the formatting is to be applied to, then 
applying the format(s) you wish to use. 

Unit objectives 

By the end of this unit, you will be able to: 

� Format labels using text formatting  

� Apply formatting to rows and columns 

� Apply various number formats to spreadsheet values 

� Use the Format Painter and AutoFormat features 

 

 

Formatting text 

Font formats can be applied using buttons from the formatting toolbar. 

 

 

Try it! 

On Sheet 1 of Sales report.xls, change the font and font size of the headings in rows 1 
and 2. Apply bolding to the labels in rows 3 and 4. 

 

Formatting rows and columns  

Row height and column width can be adjusted in order to make their contents visible; or to 
create space around labels or values in a spreadsheet. 

 

To adjust column width, position your cursor at the right of the column header, click and drag. 

 

 

Handy hint: 

When the result of a formula displays as #### widen the column that the 
formula is in until the formula result displays normally. 

 

 

To adjust row height, position your cursor at the bottom of the row header, click and drag. 
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Both values and labels can be realigned across rows and vertically in columns. Borders can 
be applied to rows and columns to define or highlight values and labels in a spreadsheet. 

 

 

 

Changing alignment 

By default, Excel aligns labels to the left of the cell and values to the right.  

Select the cell(s) where alignment is to be altered then apply alignment using the alignment 
buttons on the formatting toolbar. 

Merge and centre 

The Merge and Centre feature allows you to join cells together and centre align text across 
the merged (joined) cells. 

Select the cells to be merged, and then click the Merge and Centre button.  

 

Try it! 

Use Merge and Centre to centre the headings in row 1 and in row 2 across the top of the 
spreadsheet. Use Merge and Centre to centre the quarter labels in row 3 across the columns 
of figures relating to each particular quarter. 

 

Borders 

Borders can be applied to define rows, columns or ranges in a spreadsheet. 

 

  

 

 

 

 

 

 

 

To apply borders, select the cell(s) you wish to apply borders to and use the Borders button to 
apply a border style. 

 

Try it! 

Try applying various types of borders to Sheet 1 of Sales report.xls using the Borders button 
on the formatting toolbar. 

 

Alignment buttons 

Merge cells Borders button 

Borders button 

Click the dropdown arrow to 

access different border styles 
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Number formatting  

Values in a spreadsheet can be reformatted to display in different ways, for example, as 
currency. 

Number formatting can be applied by: 

� Going to Format-Cells-Number 

� Right-clicking and selecting Format Cells from the menu, then select the Number tab 

 

 

Try it! 

Format all values and formula results in the spreadsheet to show commas between the 
hundreds and thousands values and zero decimal places. Add currency symbols to the totals, 
average, minimum and maximum figures. 

 

Using Format Painter and AutoFormat 

Format Painter 

Format Painter can be used to copy the formatting that has been applied to one cell over to 
other cells. 

 

 

 

 

 

To use FormatPainter: 

� Select the cell that displays the formatting you wish to copy 

� Click the FormatPainter button 

� Select the cell(s) you wish to apply the formatting to 

 

 

Try it! 

Use Format Painter to copy the formatting applied to the heading in row 1 on Sheet 1 and 
apply formatting to the heading in row 1 on Sheet 2. 

Format Painter 
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AutoFormat 

The AutoFormat feature can be used to apply a preset format to a spreadsheet. 

 

 

 

 

 

 

 

 

 

 

 

 

 

To apply an AutoFormat: 

� Select the spreadsheet data to be formatted 

� Go to Format-AutoFormat 

� Choose an AutoFormat from those shown 

� Click OK to apply the AutoFormat 

 

 

Try it! 

Switch back to Sheet 1 in Sales report.xls. 

Select all the spreadsheet data and use Edit-Clear-Formats to remove formatting from 
selected cells. 

With the data still selected, go to Format-AutoFormat and apply an AutoFormat to the 
spreadsheet. 



 

Best Training www.microsofttraining.net 31 

Unit 5 Practice Activity 

 

1. Open My Practice sales summary.xls. 

2. Format all the quarterly values for all years to show a comma separator between the 
thousands and hundreds digits, with no decimal places. 

3. Format the totals, average, minimum and maximum sales for each year to show currency 
symbols and a comma separator between the thousands and hundreds digits. 

4. Change the font size for the heading in row 2 to 12pt. 

5. Use the Merge and Centre feature to centre the headings in row 1 and row 2. 

6. Apply bolding and a top and bottom border to the labels in row 3. 

7. Left-align the years in cells A4:A8. 

8. Apply a bottom border to cells A8:I8. 

9. Save the changes made to My Practice sales summary and close the file. 

 

 

 

Online support forum and knowledge base 

www.microsofttraining.net/forum 

Visit our forum to have your questions answered by our Microsoft certified 
trainers. 

. 
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Unit 5 Practice Activity solution 

Upon completion of Unit 5 Practice Activity your spreadsheet formatting should match the formatting shown in the example below. 
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Unit 6: Printing 
This unit focuses on printing features and options that can be used to control and enhance 
the appearance of printed copies of a spreadsheet. 

Unit objectives 

By the end of this unit, you will be able to: 

� Use Print Preview and Spellcheck 

� Use Page Setup to change orientation, margins and add headers and footers  

� Print a worksheet and set a print area  

 

 

Preparing to print 

The following tools can help to produce a more professional looking printed version of a 
spreadsheet. 

Spellcheck 

Spellcheck can be accessed: 

� Through the Tools menu 

� By clicking on the Spellcheck button on the standard toolbar 

 

 

 

 

 

 

Try it! 

Use Spellcheck to check for possible spelling errors on Sheet 1 of Sales report.xls. 

 

Print Preview 

Print Preview provides a view of the spreadsheet as it would appear when printed. 

Print Preview can be accessed: 

� By clicking the Print Preview button on the standard toolbar 

� Through the File menu 

 

 

 

 

 

 

Spellcheck 

Print 

Preview 
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The buttons at the top of the Print Preview screen are shown below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try it! 

View Sheet 1 of Sales report.xls in Print Preview, then close Print Preview. 

 

Page Setup options 

Page Setup can be accessed: 

� Through File-Page Setup 

� From Print Preview, by clicking on the Setup button at the top of the screen 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Next/Previous allows 

you to switch between 

previews of different 

pages 

Zoom in or out on the 

previewed page 

Opens the Print 

dialogue box 

Opens the Page Setup 

dialogue box 

Displays margin 

gridlines on screen 

Exit Print Preview 
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Page orientation 

Page orientation can be changed on the Page tab. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try it! 

Change the page orientation for Sheet 1 of Sales report.xls to Landscape. Use Print Preview 
to view the change to page orientation. 

 

Margins 

Margins can be adjusted by: 

� Using the Margins tab in the Page Setup dialogue box. This also gives the options to 
centre data horizontally on the page, and vertically on the page. 

� From Print Preview, by clicking on the Margins button at the top of the screen. 
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Try it! 

Access Page Setup features again and go to the Margins tab. Change the left and right 
margin measurements to 0.5. Use Print Preview to observe the margin changes. 

 

Headers and footers 

Use the Header/Footer tab to add information to header and/or footer areas by: 

� Using the dropdown arrows under Header: or Footer: to select from preset options 

� Using the Custom Header or Custom Footer buttons to modify preset options, or use 
alternative header/footer options 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try it! 

Choose the Sales report.xls, Page 1 option from the preset options for the footer. 

Use Custom Footer to add your name to the footer as well. 

View the changes in Print Preview. 

Use Custom Footer to remove your name from the footer area. 

 

Printing worksheets 

The Print dialogue box is used to change print settings. 

The Print dialogue box can be accessed: 

� Through File-Print 

� From Print Preview, by clicking the Print button at the top of the screen 

 

Use to select from 

preset options 

Use to 

customise 

header/footer 

content 
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The Print Range and Print What areas allow you to specify which parts of the workbook you 
wish to print. You can also choose how many copies you wish to print in the Copies area. 

 

Setting a print area 

A print area can be set so that only a certain part of the spreadsheet will print when the Print 
button is clicked. 

 

 

 

 

 

 

To set a print area: 

� Highlight the range of cells to be included in the print area 

� Go to File-Print Area-Set Print Area 

 

To clear the print area, go to File-Print Area-Clear Print Area. 

 

Try it! 

Set a print area that contains the cell range A1:J11 on Sheet 1 of Sales report.xls. 

Then clear the print area. 

Print 

button 
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Unit 6 Practice Activity 

 

1. Open My Practice sales summary.xls. 

2. Preview the worksheet. 

3. Change the page orientation to Landscape. 

4. Centre the sheet horizontally. 

5. Create a custom header.  In the left section, enter Time Out Holidays.  In the right section 
enter the date. 

6. Preview the worksheet to preview the changes you have made. 

7. Close out of Print Preview. 

8. Set the cell range A1:E7 as the print area. 

9. Preview the worksheet to check the print area has been set correctly. 

10. Close out of Print Preview. 

11. Clear the print area. 

12. Save the changes made to My Practice sales summary, and close the file. 

 

 

Online support forum and knowledge base 

www.microsofttraining.net/forum 

Visit our forum to have your questions answered by our Microsoft certified 
trainers. 
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Unit 7: Creating Charts 
This unit focuses on how to create simple charts from spreadsheet data. 

Unit objectives 

By the end of this unit, you will be able to: 

� Create charts from spreadsheet data using the Chart Wizard 

� Modify chart size, position, objects and elements 

� Print charts 

 

 

Chart basics 

Types of charts 

Excel makes it easy to create column charts, bar charts, pie charts or line graphs from a 
spreadsheet. 

� Column charts or bar charts are best for making comparisons between different items 

� Pie charts show proportional representations 

� Line graphs show progress or trends across a particular period of time 

 

Selecting relevant spreadsheet data 

The first step in creating a chart is to select the labels and values that are going to make up 
the chart itself. 
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Try it! 

Select the cell ranges A4:A10 and H4:I10 from Sheet 1 of Sales report.xls. 

Handy hint 

Hold down the Ctrl key while using your mouse to select non-adjacent ranges of cells from a 
spreadsheet. 

 

 

Using the Chart Wizard 

Once you have selected the relevant data from your spreadsheet, you can start the 
Chart Wizard in order to create a chart from the data you have selected. 

 

 

 

Step 1 

Select the type of chart you wish to create. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Chart Wizard 
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Step 2 

Shows the data range you have selected in order to create the chart. 

You can reselect data from the spreadsheet at this stage if necessary. 

 

 

 

Step 3 

At the third step, chart titles can be added in and data labels can be added if you wish. 
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Step 4 

The final step allows you to choose where the chart should be positioned in the workbook. 

 

 

 

 

 

 

 

 

Click OK to finish and produce your chart. 

 

 

Link between source data and chart 

The data selected to create the chart (the source data) is linked to the chart itself. 

Therefore any changes made to the source data will be reflected in the chart immediately. 

 

Try it! 

Change Sandra’s actual sales in cell H5 to 80844 and note how the change is reflected in the 
chart. 

 

 

Modifying charts 

Charts can easily be modified once created. 

Moving and resizing charts 

Embedded charts can be moved and resized once created. 

 

 

 

 

 

 

 

 

 

Try it! 

Move the column chart underneath the spreadsheet data and make it larger. 

Position the cursor inside the chart area and 

hold down the mouse and drag to move 

Position the cursor over one of the square handles at 

the chart corners and drag in or out to resize 
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Changing chart type 

The chart type can be changed by: 

� Selecting the chart and going to Chart-Chart Type on the menu bar 

� Use the Chart Type button on the chart toolbar 

 

 

 

Try it! 

Change the chart into a bar chart using the menu bar, then back to a column chart using the 
chart toolbar. 

 

 

Adding axis labels to the chart area 

Chart title and axis labels can be added or altered once the chart has been created by going 
to Chart-Chart Options. 

 

 

 

 

 

 

 

 

 

Try it! 

Add the label Salesperson as the Category (X) axis on the chart. 
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Displaying chart labels 

Labels can be displayed next to chart objects, for example, percentages can be displayed 
next to segments of a pie chart. 

 

 

 

 

 

 

 

 

 

Try it! 

Add chart labels by selecting the chart and going to Chart-Chart Options on the menu. On the 
Data Labels tab, tick the Series name option and click OK. 

The words Actual and Target should display above each of the columns in the chart. 

 

 

Formatting chart objects 

The various parts or components that make up a chart are called objects. Objects can be 
reformatted by: 

� Double-clicking on the object 

� Clicking on the object once to select it, then using the Format button on the chart 
toolbar 

 

 

 

 

 

 

Try it! 

Change the colour of the columns for one of the salespeople. 

The Format button 
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Printing charts 

Embedded charts can be printed by selecting the chart and clicking the Print button. Where 
charts are displayed on their own sheet, clicking the Print button will print the chart. 

 

Try it! 

Select the embedded chart and click the Print Preview button to show that just the chart will 
print when selected. 

Close out of Print Preview and save the changes made to Sales report.xls. 
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Unit 7 Practice Activity 

 

1. Open My Practice sales summary.xls. 

2. Create a column chart in its own sheet based on the quarterly sales for the years 2003 to 
2006.  Do not include the yearly totals, averages, minimum or maximum figures. 

Hint: do not include the labels for the years when selecting data from the spreadsheet, 
otherwise Excel will display these as bars in the chart. The year labels can be 
incorporated into the chart at Step 2 of the Chart Wizard. 

3. Change the colour of the bars for one of the years. 

4. Move the legend so it is positioned underneath the chart. 

5. Save the changes made to My Practice sales summary and close. 

 

 

Online support forum and knowledge base 

www.microsofttraining.net/forum 

Visit our forum to have your questions answered by our Microsoft certified 
trainers. 
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Unit 7 Practice Activity solution 

Upon completion of Unit 7 Practice Activity your chart should match the chart shown in the example below. 

 

Sales by quarter 2003-2006
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